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56 25.110814 162.125.17. 192.168.1.102 TLSv1.2 388 Application Data
57 25.118831 192.168.1.. 162.125.17.3 TLSv1.2 493 Application Data
58 25.234470 192.168.16. 192.168.160.2 NBNS 110 Refresh NB LENOVO-E130¢20>

25.480144  192.168.1,. 157.55.235.1. UoP 183 64930 + 40018 Len=141

25.509785 162.125.17. 192.168.1.102 TCP 443 - 50793 [ACK] Seq=335 Ack=440 Win=83 Len«d

25.788741  157.55.235. 192.168.1.102 uopP 40018 « 64930 Len«21

Frame 1: 66 bytes on wire (528 bits), 66 bytes captured (528 bits) on interface @
Ethernet II, Src: 68:17:129:47:¢3:77, Dst: f8:d1:11:196:90:1¢2

Internet Protocol Version 4, Src: 192.168.1.102, Dst: 119,235.235.84

Transmission Control Protocol, Src Port: 50736, Dst Port: 443, Seq: 1, Ack: 1, Len: 12
Transport Layer Security
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maiudeyadie TCPDump TneunfiudasyuuliRnismszga Unix/Linux asiiuiiniin
Tusunsuitugudmiumaivtegaufnimnlfduiiuguduinfoguilbiduiudosdin
Wintiufie TCPDump lag TCPDUmp annsavimsiiudeyauinifinldmilsurulusunsy
Wireshark dmsumsldiann TCPDump Wu axiimsvhanuludnuae Command Line Ssazdiosd
msszyfds 1wy Inslnnea wiete uazvunvesdeyaidesnsdmiu Wudu

mas sUsuumdTumsldanu TCPDump axilassatn dail

&3 # tcpdump -i eth0 tcp dst port ®o=o -w capfile.pcap 31NH18814
ds andunisdsli TCPDuMp ﬁﬁﬂﬂiLﬁU%@@JaﬁLﬂ%@ﬁ’m eth0 TnaazAesdl TCP Uatemng
Ju Port 8080 waqmﬂuﬂwmmiwauaquhLUuMa%a capfile.pcap LLaUmﬂ%maﬂw
TCPDump Lwamul‘l/\lamam%ulaﬁna capfile.pcap ‘tJumLLammamstm # tcpdump -r
capfile.pcap
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mac MsIAUTaYaRIY Microsoft Network Monitor (GUI) dmiuunsesdnsidl
ngazifouinssndalunisdanislusunsusing o Adadsadduiades ity Sdefuualild
TUsunsuiifedldsusesaugniesuaenduain Microsoft wiiiu Tunsdiflulésuounnas
lidanunsafnsalusunsuld lunsdlfl Microsoft Network Monitor azifusadaelunns
L.Lﬁ‘ﬂz:wﬂuﬁ’gmmmilﬁu%’ayjaLﬂ%asu'ﬁ8mﬂmémﬁﬁmmﬂﬁmmﬁmﬁ’u dnsunisvingu
994 Microsoft Network Monitor Aagfinannisideafuiulusunsy Wireshark waa1unse
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m‘W‘ﬁl oo’ LUIHNTU Microsoft Network Monitor

nstfiudeyasae Microsoft “netsh” (Command Line) ns@itidunisldan
TUsunsufiuniu Microsoft Windows wutieniufu Network Monitor wavziidelaiuiou
11nN31 Microsoft Network Monitor #1541 netsh Lﬁuﬁwﬁqﬁgﬂamﬁﬂmw%mﬁu Windows
wesudneuindsldsidudemiinanuasindslusunsuiiupusn dudunsldau netsh
awduludnuay Command Line winiu Ssenaeeliawmndmiuruiifauduaeiunisldn
Wsunsaludnuaass GUI dmsusethsmsldanilusunsy Microsoft netsh asidussnnd o

= Administrator: Command Prompt - olEN

N\Windows\systeni2inetsh trace start persistent=yes capture~yes tracefile~d:\ne
ttrace.pcap

Irace configuration:

status: Running
Irace File: D:\nettrace.pcap
Rppend : Of §
Jircular: On
250 MB
Of§

\Vindows\systend2inetsh trace stop
..... done

erging traces ... done

wnerating data collection ... done
The trace file and additional troubleshooting information have been compiled as
“"d:\nettrace.cabh".
File location di\nettrace.pcap
Iracing session was successfully stopped.

iN\Windows\systeni2) v

AT e F0E19N131E9U Microsoft netsh iteiiudeyalusyuuinsotig
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n1slduluguuuy Remote capture az1dun1snaunaIuniIsvnaIuves Wireshark
Ul Windows kazlUsunsy TCPDump Uu Linux #dnn1svieufie vuades Windows
Irfoniinisadne ansuddmiunis Login Wnlufiedes Linux Tneagdearinisinune
Parameter Username wae Password fisndustensldeuliasudau saumamdwes TCPdump
fifoens Uszlomivosnsldau Remote Capture Asanunsnvinnisuefinosteyaiiinuy
1304 Linux 3edlafldfarunsadndald uazirdoyadilduuansuadl Wireshark vy
Windows leluiuiiileutdamlunsdfidosnsinsgidymiiintuludneas Real Time
winsveuludneasiferidedodiowuiu fe iuﬂiﬁ%’amaﬁlé’mwmmﬂ%mu
TCPDUmMp mnﬂmulﬂmﬁmmﬂmﬂmmﬁ‘umumimmummaﬂmmau 9 Tuszuu & mmm
Wnsldaueierielnesindadld dmivansudifienisldan Remote Capture Fanmil me
suidiulgilusdadegns Script Wielwauisa Remote Capture ¢ azdosinisldau
TUsunsy plink Imaiﬂam’iu%é’faﬂaméﬂagﬁ C\Telnet\plink.exe -ssh -pw [password]
root@[IP Address] "tcpdump -n - ethO -w - " | "C:\Program Files\Wireshark\wireshark-gtk.exe" -
k -i fredaazanunsaldanuiuteyainsetnsliegvauysal

G0/1 G0/2 \
Linux

Windows

Switch A

Wireshark Login credential == Command TCPDUmMp
SSH tunnel <&—— TCPDump data

Windows Linux

AN e ﬂ’liLﬁU*ﬂJa;JUaﬁ’JEJmﬁﬁ’l Remote Capture (Wireshark+TCPDump)

m.mee N5 Remote Capture $198194n11511 Remote Capture ﬁLﬁuiﬁ%mﬁmﬁqm
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HuAsnsfiendunisvihnuiiugiufenisdesdeiuves 29siih Sududnisdeansuaud
wifusuuie 9 laudiniseenwuuilusnsawisifiensldan weldmumniznig wu
Network TAP wuuane UTP CAT5/6 wagsuuane Fiber Optic iugiu Tnevalu Network TAP
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Ao 1io39n Network TAP avilvdyaraiildlunisdeanslusyuu LAN seuas
Faagyinlsudoyaianainld Snuszifunilsde Wedosnisur Network TAP sty
wdenhmInenasuaureAIesiifioinNIsnsIvaeusenuazii Network TAP iundeusie
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Hamleguuaindiuiertuivaindvesgunsaififesnisnsaasudeyauuszuuiaietely
nsdifiiitiym dlunsdionmshldennvietiaruliasan Wy aindegauazenis vieey
Tufesquédoyadedosiinsimuanarlumsidieen liersagsinlinsiaseinioudly
Ygymlal Farfud i mawmun e dumsvhauwuy Remote Switch Port Analysis : (RSPAN)
dieuflutlymidandn n15vatuues RSPAN agdoarinnisiiiu VLAN fiaviuandnuils
VLAN tileth1 VLAN fdfisssinldfanudu Remote VLAN dmdunisdstioya SPAN Tufiainddu

f79819N15YIN9IUVDS RSPAN A9NTNT &en

ANT & FIDY1NITVINIIUYD RSPAN

1N Md <o LeTosfivinisfindslusunsy Wireshark iiovinistinanzidoya
fio PC-Z Ainssagd Switch A uaziaies PC-B uaiesiidiyuuiniu dauaszuusionis
flagsiinns dediayanis SPAN was Switch B ndUlU# Switch A dsduiilomadonsiolalfey
vuaindinfeaiu Jafeddilerdu RSPAN unu SPAN nuUnf TnedsiliutiuanAenisnaan
Remote VLAN snafilsinanlidhediu wageygeliinsdsdoyasonludl Trunk fideusiof
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aaoc NMaNUTayamensld Hacking Technique mstﬁu%’agaLﬂ%‘*d’]mwuﬁﬂu
Witlduugdhlihluldenluszuuate Wesnndunsnsgyih dhanglunmsifianguune
EJ’]EUﬂE‘ULLUUViﬁx‘i Asuuzhnsyeurensiegldfediwoanaiiag 138191 ARP Spoofing
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Inel¥n1sdnasanisviuriulysunsuazasseuun3edie As EVE-NG lagldnisvinnu
$amiulusunsu VirtualBox ilelifiuntsyinuitauysaiinnu dwsu mevhanlasaziden
sefinisnanddudiuresnsinismaaswioly nmsiiuteyalussuunietielaenisldau
ARP Spoofing Haztfiunavaanigunsnl PC-A dsteyanisdeanslufi PC-B fifinisvin ARP
Spoofing Wiitevinsifuteyanisidendeluiineusnieietsiilasunfasdesiinisdstoya
Wilisiwofiilefinnsmaenty PC-A ynsdadoya nisdeanslufl PC-B unudatu PC-B
Jeanunsavhmstudindeyanisdeansves PC-A 1d fanmdl e

A @< FBE19N199119IUTD9 ARP Spoofing

W CA\Windows\system32\cmd.exe O
AN\Usersa \NS-VNin 7D

er S-Win
r S-Vin
or S-Win
er S-Vin
er IS-Nin 7D
ser JS-Win 7

lotantacas 108 1 1
Internet Addrezs ‘hys ice Addres
19.1.1.1 cd e -8 -99
186.1.1.4 8 27-7b-91-9Y
4% =11

We-98-16
S50-00-88-f «
-ff-fa
Fr-fr-fi

ATl @& MAC table UA3ed PC Aaunisvi ARP Spoofing
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amoed HATLAAIINNSY ARP Spoofing ﬁummmaléfﬁmmwﬁ <& lapundilan
PC-A axiinn519 ARP vesmsilendeiuissinesaslugy usdlslafniudl PC-A gnvinnisein
Auteyalulnenisldaru ARP Spoofing luszuuia3er1em1519 ARP wedlA3es PC-A
wAsuludslunind o Fsagsiln PC-A da doyanislduszuuinietneluil PC-B fifad
¥1 ARP Spoofing agjiiutes windaing MAC Address os3Uaztfiuldinnavesnisyin
ARP Spoofing 9s9il3 MAC Address w84 Router iUasuluidu MAC Address 84 PC-B uiu

@Y C:\Windows\system32\cmd.exe SR %™

s \WS

s \WS

s rs\WS
rs\WS
s \WS
s \WS

lotanfacea s 18 1 1 Bach
Internet Address Physical Address Type

#1-24-9¢c-98-1¢ dynanic

8827 #1-99 dynanic

L 3 ] tE=rr—1t stat i

#8-5S5¢-880-00-16 at i«

B0-50-00-00-f stat i

M -Se-7f-ff-fa at i«
FE-Ff-£f at i«

S-Win 7>

S-Win 7>

Win 70

S-Win 7>

S-Win 7>

s\WS-Win 7>
C:\Users\WS-Win 7> S

A7 &5 HaTfinaINN13911 ARP Spoofing UiATeafideInsiutoya

aaneo  HUNTIELYelUTUATU Wireshark din1sudantindandn o panu & du
Insusiaydruvzivonazintngang 9 Al
. < A = [ = 4 v
aaeo.e Main Toolbar lHulyveATesllonaniiionsanisldanu
lUsunsu Wireshark lagagiiadsidAgyAs Start wag Stop Capture lddusunistudin
Packet YayatussuuinIaYiey fewnfe Edit/Apply Display Filter, Edit Coloring Rules ua
Fdit Preferences lagagiinnsnaniiesivasduntudiuseld

v A

mamobl Display Filter Area udruiiddgiiannazgnnaifsludiui

<

o

esnudiuiaazldlunmsvhnisnsesdeyadideanis ietwnuanmauaziiasizinisg
nuluddusiely

mameo.m Packet List Pane WudiuilduanineazidonvouiiniAniiiv
foyauld lnsazuanisisazdendosiuii IP Address InslnasaunzsioasiBondosiy
younifintu

mm.eo.c  Packet Detail Pane WudiuiilduantsivasiBonnig o vos
wiazuinifinlnsazden Tnsazuandoyaluneandenlatuindudsydumadluauisdoya
ﬁa&ﬂu Layer Application
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mmab.& Packet Byte Pane anfuntsuansdeyavesufiniindulusuuuy
vostoyagruduvnuaziisnws AsCll Tnglunsaifideyalifinnsidsiaszarusaviiniseu
doyalududeanuléiud dwiusunisesaysing q veslusunsy Wireshark a1ansng
167 fsnmil o

M wiria - o X
File Edt View Go Capture Anahze Statatcs Telephony Weeless I3
am 0 BRE R«+a@Ti i S QAQQD
— |

R i o ougir ¢ B - +
Mo Trve Source Cestrason ool Mrammilength b o

2472 ap.20492 122170170 192.168.43.197 o 1 443 « 60090 Len=1127

473 40.200492 72.34.2%.78 192,168 . 4319 e o4 443 < SA0M [ACK)] SeqellTE Acks

475 40.200568 192.168.43.197 204.154.1100.1 o 54 S4839 - aa3 [ gl Ackel ¥

2476 40.200619 192.168.4).197 m.ar.nn e » G0690 « 443 Len-u8 ——

U477 40.200865 192.168.43.197 204,154, 311.134 TSl $7 Client Mello

2478 40.296048  192.168.4).197 7.7 e 48 GOS0 « 443 Lene10) v

Frame 1300: 141 bytes on wire (1128 bits), 141 bytes captured (1128 bits) on interface @

Ethernet II, Src: 34:16:4b1dciecie®, Dst: S4:b1:0e:74:87:21

Internet Protocol Version 4, Src: 192.168.43.197, Dst: 52.229.174.172 °
Transaission Control Protocol, Src Port: S4023, Dst Port: 443, Seq: 314, Ack: 3524, Len: 7
Transport Layer Security
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maen M3adrauazi Fitter Widaululusunsy Wireshark dlaiswinmsidudoya
Tusruuiterieduuiuda ludunoudeluisazdesidoyaiilduAnuinisiunie
Anszmmahauiiiaund wilaeitiluudlutuneumafudoyadiulngdnagyiniaiu
foyauludnwnsly “wosiigaiolidew” islunsdithiansnfiagvhnsfvdoyadilé
Uoe 9 Tngenaazfianmguiainn1sdosiinisve Change Request mutunou 9o1de
svaznatwazdunoulunisdfiunisfiuiy viewmafiiaduduoisaghiamsnasng
anunsaibuuAedfulddn (Re - Produce) nsotdumgnisaliidessanufivioyauen
anuiidaliannsneoninléven 4 fuiu dedeyaiitafvuldfvualnajuasdadudougs
mslde Fitter Tulusunsy Wireshark 3afudesddey Tnodudunouiiazanunsavinlais
szyvaunvastoyaiiosmsldandeauarantuandoyatiugruiifinuelug Taealuud:
nsldaru Fitter Tulusunsy Wireshark azUszneusnedeyadisianaut@ves Input Filter
Favun o SULUY M7 o
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yilpvasdayn Tgszuu ID M%@%’aagaﬁéfaqmié’wqﬁqﬁa Host, Net, Port
LGS dsgyfiamevestayanieves ID Src, Dst
Inslveea T¥seylusinaoadifimsldaunuuiameiaigas | Ether, IP, UDP, HTTP

M5N o AENURYD4 Input Filter

maoc Inglunisldan Filter 228 Input Filter agfivsuanisnToraamild i

Filter -> ip.addr==192.168.10.1 1@®n IP Address 192.168.10.1 U UAAINS LAy

Filter -> ip.src==192.168.10.1 1@®n Source IP Address 192.168.10.1 U UAAINE,

Filter -> tcp.port==80 donlnsnAsa TCP Port 80 11uanna Lunu

ndeesfisnanligisauuuy anduldifinslinuaiomue == of lngi
AT RINUNY “==" szidunguuss Operator ﬁﬁﬁuﬁwﬁﬁau%aﬂa Input Filter @946
W1livenu wagea Operator ﬁé’ﬂgmmaaaﬂlﬁtﬂuﬁﬂaaﬂﬂejmﬂaa 9] A® Operator WU
W3suieu (Comparison) kay Operator kUUATINE (Logical %58 Boolean) Tngazlans
nNauvae Operator MAowuUEnun T o wag o dil

Comparison operator AN95U1Y
== Ay
I= fanlawindu
> AN
< fAtounin
>= ANUININTDINNAUY
<= JAtesnuseawiniu

AN5197 o NShE9U Filter

Logical Operator AN95U"Y
And / && Logical AND
Or/ || Logical OR
Not /! Logical NOT

AN99T o Logical Operator




- &o -

mamec N1IHNNENTEY Input Filter annsavinlddudouinniu Tnsnsldmnusmiy
nslfia3ewmane “()7 iWeldlunisuennguues Input Filter lHauiulidodafiadng
sieluil

Filter -> ip.src==10.1.1.1 && ip.dst==10.1.1.2 1d0n Source IP Address 10.1.1.1
ey Destination IP Address 10.1.1.2 U LEAINE LAY

Filter -> I( ip.src==10.1.1.1 && ip.dst==10.1.1.2) \@enuanua IP Address axlsile
71 % Source IP Address 10.1.1.1 ua Destination IP Address 10.1.1.2 1UaAIHA

089 nsdifildanunsald Filter lip.src==10.1.1.1 && lip.dst==10.1.1.2 unulg
wselda1w15097 Input Filter %38 Operator Wuumg 9 16 Alusunsy Wireshark Aazdaa
Frggrngemazantumsldau Fitter 1 Taovinnsaand Fitter vuiy fannil e

Am @ RREB QRex2=ZF 3 5|EQRAQAQHE
(] Apply a display fiiter ... <Ctrl-/: ‘\_‘
No. Time Source Destination Protocol Frame Length

A &€& NISKENNALYBY Input Filter

am.enloo Display Filter
Tunsdfidesnisifin Operator Wannldeu liinasna Filter wdaay ﬁ
wmmﬂ‘wmmﬂmum Tsranunsadenidu Display Filter Lmemiﬂm Expression Lilg
Wil Option fignurdseng 9 dmsunisldau Operator Fanndl e

M Wireshark - Display Filters ? X
Name Filter S
[Non-HTTP and non-SMTP to/from 192.0.2.1 | ip.addr == 192.0.2.1 and not tcp
Mo ARP and no DNS. not arp and !{udp.port == 33)
HTTP http
TCP or UDP port is 20 (HTTP) tep.port == 80 || udp.port == 30
MNon-DNS {udp.port == 53 || tcp.port ==
UDP enly udp
TCP only tcp
IPX only ipx
IPv6 address 2001:db8::1 ipvb.addr == 2001:db8::1
IPv6 only ipvé
IPv4 address isn't 192.0.2.1 (don't use != for this!) !(ip.addr == 192.0.2.1)

IPv4 address 192.0.2.1 ip.addr == 192.0.2.1 ~
< >
+ | =0

ATl Display Filter
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ﬁasLﬁaTiﬂuﬂﬂi%’Uﬁjﬁﬂaq Filter String Tidnudaes Coloring Rule wiaziiiues wazly
nsdiAsA1es Filter Aidosnsidaulals ﬁ’mmamﬁwmﬁmg Coloring Rule tagyinn15in
Filter String lUlgmududuuuulunisyi Filter Tamewuiy

‘ Wireshark - Cclorlng Rules Classic T >

Mame Filter i

Diouble ciick to eclt. Drag fo move. Bules aow processed in order wnid 8 maich & fownd

+ = M Fﬂ o Kdsmrs [Cany

E Copy from ~ Cancel Import Export Help

Al o Coloring Rule

.o Coloring Rule
\flos91nlusunsy Wireshark finnsuansnafidudounay Coloring Rule 7ilé
asaunlvenavgliiismenanisldanuvegly Ferfulusunsa Wireshark Feeun vl
mmaamw Colorlng Rule Laﬂmmamiﬂ@m New 1u Coloring Rule Immaﬂmt,mmm
winsTunn e Coloring Rule Flnmlnuiisdeanisle Insesdewinisnidonas
Filter 1388 uonanniiganunsainnisuiladues Foreground way Background lémnui
éfaqmﬁmmmyﬂ/ﬁw
e.enlom  Statistics Conversations Tun15l49u Wireshark
TagunAudaziufiniindisninsfudeyatwnduduiumn udlunns
srydamyensnsadeunisiniausenitaaies Client way Server awiinisAndeiuiiles
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<MENU><DL><H4></H4>
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oe0eRaF4
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exec/->1,</A><A HREF=/level/02/exec/->2,</A><A HREF=/level/@3/exec/->3,</A><A
HREF=/level/04/exec -

OO A
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Round Trip Time for 192.168.1.102:50736 — 119.235.235.84:443
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€olo.e NISAU Image Ram e FTK Imager

I ) AccessData FTK Imager 3.1.1.8 = |EI|5|

File | View Mode Help

13 Add Evidence Item... wm | T ﬁ E ? .
N S Add Al Attached Devices | [File List %]
% Image Mounting... heame I B I Type I R I

Remove Evidence Item

Remove All Evidence Items
Create Disk Image. ..

Export Disk Image...

Export Logical Image (AD1)...

Add to Custom Content Image (AD1)

Create Custom Content Image (AD1)...
Decrypt AD1image...

Verify Drive/Image...

|m Capture Memory... |

] Obtain Protected Files. ..

Detect EFS Encryption _>| ;I
Export Files. ..

Export File Hash List. .. b LI
Export Directory Listing. .. l:“:“:l Y
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FosRnsalusunsy FTK Image asldluniosnou andulddalsunsy
W&lUT File > Capture Meory amndulugesii o vinisdenlwdlil USB flasliiulng
Tutesi ﬁ'lmi(?ly’ﬁaimaﬁumaqa .mem mﬂﬁ?uﬂﬁmﬂ%wmagﬂﬁ Icludepagefile uaINAY
Capture Memory
eololo 1UTHNTU MagnetRamCapture

=R = |
" Mapnet RAM Capture - o (;U- « Downlosds » RamCapturesid w49 | Seorch RamCaptunsts P
|
MY MAGNET —-22e2]  Fomms D o S e
Copyight © 2914 Magnet Forermics Inc
FORENSICS ¢ Favort :
DL/ o, e Liovantics. com Segnent som: Don't ."D::
Sove FAM Captre 16, P b ¥
‘ B Downloads q S
| % Recent Places ¥ Rl
‘ = AR 20150927 mem PamCapturetd RarCagtureDrve
| Coancet e 0m - - Libearies “7’1
% Documents
o' Music
S Pictores
B videos
- ad
20150927 mem Date moddied: 3/27/2015935 PM Date created: 9/27/20159:34 PM
MEM Fie ze 449 GB
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Tdeu USB 7idlusunsy MagnetRAMCapture.exe a1ntuvin1ssu
Wsunsu Tnelusunsuasliisndonsumislunsdadivlng Tneluiitsasslvg3ivhee
MnduriinsRdelng nsazdesiiuuanadu raw naditliaunsadaaentidlienadianmg
1970 RAM fiffediviaulaiiiieswe 1vins zip/rar Indreuudaresdaasnlng zip an

<olom LUsHLATH RamCapturer

—

%] msvep110.dIl
1% mever110.dil
¥, RamCapturefd.exe

=T =1

=
===
[ R
[ = SR
[ I

(=T~

—

%] RamCaptureDriverfd.sys

& 111 ..
a1 ..
8 10:11 ...
a1 ..

Application extens...

Application extens...

Application

Systemn file

646 KB
830 KB
58 KB
34 KB

d = Belkasoft Live RAM Capturer

Select output folder path:

V1 arunadlp forensicil Tusunsuy forensicixe4

Loading device driver ...
Physical Memory Page Size = 4096
Total Physical Memory Size = 33536 MB

Cancel

Close
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TUsunTu RAMCapture.exe fivonnsiilifosfnfslusunsuasiuiaio
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AMsIAY Image Hardies faglusunsu FTK Imager
NM3YN9UZI5UINAANT File > Create Disk Image... > Physical Drive

ﬁ AccessData FTE Imager 2.4.2.32

File Wiewr Mode Help

£ Add Evidence Item... .= = oaee | '
&8y  Add all aAttached Devices ] File List
g5  Image Mounting... Flame | size | T

Remowe Evidence Itermn

Remowe All Evidence Ttems

I| Create Disk Image...
Export Disk Image...

Export Logical Trmage (AD1)...
Add to Custorm Content Image (AD1)
Create Custom Content Trmage (AD1)...
Decrypt AD1 image...
Werify Drive/Image...

mem  Capture Memory...

m Obtain Protected Files...
Detect EFS Encryption

Expori Files... I
Export File Hash List...
Export Directory Listing...

Exit

AT o NSAUNANEIL RAM

Select Source Y

FPlease Select the Source Evidence Type
{* Physical Drive
i Logical Drive
i Image File
o~

Contents of @ Folder
flogical filedevel analysis only; excludes deleted, unallocated, etc.)

Femico Dewice imultiple CD/DWD)

H
.

Mext = Cancel Help
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PMNUUINNSEDNI1SAREANAZYININITE51e Image

Select Drive >

— Source Drive Selection

Please select from the following available drives:

I\\.\F’HYSIC.&LDHIVED - HGST HUCT0N 360C 55204 SCSI Disk [;I

AP HYSICALDRIVED - HGST HUC101 860CS55 204 SCSI Disk Dewis
SAOPHYSICALDRIVET - HGST HUC101860C 55204 SCSI Disk Dewi
SAOAPHYSICALDRIVES - WD My Passport 2861 USB Device [1000G

<Back | Finish | Cancel | Help

AT oo MIAUMENGIU RAM

MUAEN1IINAYY Add

Create lmage

—Image Source

| W \PHYSICALDRIVED

Starting Evidence Mumber; I 1

—Image Destnaton{s)

Add... I Edit... I Femowve

Add Owverflow Location I

v werify images after they are created I~ Precalculate Progress Statistics
[ Create directory listings of all files in the image after they are created

Skark I Cancel I
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AasgnsiienuLuUlng (E01ATIan) wisunselia

Imag
[y
Select Image Type X
Please Select the Destination Image Type Imag
= Raw (dd)
= SMART
& E01
- =
= AFF

W ver
[" cr

Evidence Item Information

Case Number: ‘last_Evda\n

Evidence Number: ‘E2D7D3

Unigque Description: ‘

Examiner:

Notes ‘

< Back Next > Cancel

Help

| Next > Cancel | Help |

Start Cancel

AMA alo NSNUNENFIU RAM

a0 a A I3 I
denfiunasiaziiulng Image

Imag
|
[wy

inags Destination Folder
[Era 20703 " Bume

Browse For Folder

Salect the destnation folder for the image

- Recovery Image (Dk)
o DATADRIVEN (E:)

00 walvmm
bnaye Flessse (Excudyy Extevsion] D tast HTMALS
ot 827040 .
2%a2
~ . Image Fragment Size (MB) r -
For Flaw. E0, and AFF formats: ) = do not rasgmert {Riaje_Home_Edition
Compression (J=hone, 1sFastest, ., 9=Smallest) |5 = lab_G20703
A_image
Use AD Encsyption [ s
Folder Hewy frsldier
Back | | Cwee | hee |
[ Moo tewroiser | [ o |
] Coeel |
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Create Image X

—Image Source

| 1\ \PHYSICALDRIVED

Starking Evidence Mumber: | 1

—Image Destination(s)
E:Ylab_&20703\tast_620703 [E01]

Add.., Edit... | Remove

Add Overflow Location |

¥ verify images after they are created | Precalculate Progress Statistics
[ Create directory listings of all files in the image after they are created

Start Cancel |
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Mandiant Redline”

Collect Data #4149 Image

Craste & Stardard Colectoe »

o empn e (DU Ram

Croane an JOC Saarch Colecto

Analyze Data

s et . i
e S AMMTUTATIZV
o a5

Recent Analysis Sessions

AR angen e v1 90 mana -

A7 el 1USWATH Mandiant RedLine 3

Mandiant Redline”

Collect Data Create a Standard Collector
Create a Standard Collector > Configures a package which will collect all of
- the data needed for Redline to score and
Create a Comprehensive Collector >
assess a computer

Create an IOC Search Collector >

Analyze Data

From a Collector >

From a Saved Memory File >
Open Previous Analysis >
Recent Analysis Sessions
AnalysisSession.mans >
AnalysisSession.mans >
stuxnet.mans >

zeus.mans >

A7 2o 1UswATH Mandiant RedLine 4
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Redline’

Collect Data

Create a Standard Collector >
Create a Comprehensive Collector >
Create an I0C Search Collector >

Analyze Data

From a Saved Memory File >

Open Previous Analysis >

Start your Analysis Session

Select Target Platform

Collector can be created only for one the following platforms:

® Windows osx ) Linux

Review Script Configuration

You have chosen to create a Comprehensive Collector

1 fivunBouduiady

Acquire Memory Image 2. Ainwoaviugn

Specify Collector Location

etc) is created,

Save Your Collector To:  Open Folder

@enzzuuufiRnrsideanaiiu

The comprehensive collector will gather most of the data Rediine is capable of collecting. Note; this will not collect strings which can be manually enabled by choosing to edit the
script below.

[ Checking thiz option will acquire sn image of memary that can be uzed to accurately acquire procesz memory and drivers during analyziz in Redline

1. Your Collector package will be created and saved to the location you specify below.
2. On the Windows machine you want to audit, run the 'RunRedlineAuditbat' seript, preferably from removable medis (e.g. a USB Hard Drive). The script will run the Collector, as
you configured it, and save the results to & folder named ‘Sessions\AnalysisSession', Every time you run the script, & new folder

3. When the collection is finished, transfer the results back to your analysis machine, then double-click ‘AnalysisSession.mans' file located inside the AnalysisSession folder.

A copy of these instructions can be found in the location you specified, in the file ‘Readme.txt'

3. s¥avame fuaemadmiuiuing

[EBrosRE|

A9 <o TUsUNSH Mandiant RedLine 5

[raRsaviinsiruansRsaitil ivainranswiu Wy Memory, a1sanan, wosia

YDITTUY, 1AS0U18 Lazsensiiiaiudu 9 Wudu auaeviinisasalamesuatenng

dmsuldinudoya wusdlilu USB 7 Format 18u USB 7iliififeya uazna OK

Redline’

Collect Data
Create a Standard Callector >
Create a Comprehensive Collectar >

Create an I0C Search Collactor =

Analyze Data
From a Saved Memory File >
Open Previous Analysis >

=

Styles

Select Target Platform

View and Edit Your Seript for Windaws

pe—— [T C T [T T

1] Pracess Listing
PID
Pracess Name
Shortest Matched String
You have chosen to creal L Content Reger

The comprehensive call
script below. ] Handles

[#] Sections
Edit your seript

Review Script Configurat]|

[#] 1mperts
¥ Exparts

Acquire Memary Image| | (7] b
[ Checking this eptier| || | SHA256

(7] Use Raw File Access
91 Drteees Enermertion

¥ 1imports.

(¥ Exports.
.

you configured it and saj
ete) is created. [¥] Hook Detection
(¥ IoT

[¥] S5DT Inline.
] Verity Digital Signatures

Specify Collector L

1. Your Collector packagel

2. When the collection is

A capy of these instructiq
Acquire Memary Image

Redline.

Save Your Collector To:

¥ Ports
] strings

] Verify Digital Signatures
] Detect Injected Sections

[ sHat
[F1 MemDs

s
] Verty Digitel Signatures

¥ Strings

[C] SHa

SHAT
(7] Use Raw File Access

[¥] 55DT Index
(¥ Drivers

[ Acquire an image of memory that can be used to accurately acquire pracess memory and drivers during analysis in

- o =

[#] Show Advanced Parameters.

chaosing ta edit the

will run the Collectar, as
sion2, AnalysisSessiand,

Session folder,

Cancel

Cancel

A Qo 1UsWNTU Mandiant RedLine 6

PNUUILLNADIVDANULINF DY (RBIUALaUR AL ULAS DIRBURINES) LiNaUBNTURDY

s dlUldanuanusanalale



- & -

Create a Portable Collector

Copying the Agent Executables

Collecter Instructions

1. Your Collector package is created and saved to the location you specified.

2. On the Windows machine you want to audit, run the ‘RunRedlinefuditbat’ script, preferably
from removable media (e.g. a USE Hard Drive). The script will run the Collector, as you configured
it, and save the results to a folder named 'Sessions\AnalysisSession 1. Every time you run the
script, a new AnalysisSession folder (AnalysisSession2, AnalysisSession3, etc) is created.

2. When the collection is finished, transfer the results back to your analysis machine, then double-
click *AnalysisSession.mans’ file located inside the AnalysisSession folder.

Choose from one of the options below or close this window to return to the start page:

Open Directory Containing Portable Package

A copy of these instructions can be found in the location yeu specified, in the file ‘Readme.tdt’

AT e TUSUATH Mandiant RedLine 7

panldaulinsulnddo RenRedlineAudit.bat Azwanantin cnd VU Wlavinauasa
11 cmd 399zugly (@12191a1ARUTI9UIU) D19D9N1SENLANAYIIN1SUA cmd

— TT ! —

=1 Applicstion Tools  ©= — m] > feDi AABRCCDC
lQ.. subtieRef.. -
Home Share Wiew Manage O[
1~ » ThisPC » Local Disk (C) » Users » User » Downloads > Cap_Ram N Search Cap_R.. @ | =
- T
~ Nare Date modified Type Size

s Quick access

= Dok . 64 1 21425PM  File folder
eskto
" 86 1 2 File folder
!' Downloads ’ [E] elevate.cmd 4 Windows Comma... 2 kB
[Zl Documents »* elevate.vbs 4 VEBScript Script File 4 KB
& Pictures ks finishAnalysis.js 4, JavaScript File 2k8
@ OneDrive - Persone! getNextSessionFolder js 4, JavaScript File 1 K8
getPath.js 4, JavaScript File 3KB
[ This PC [=] Helper.bat 4, Windows Batch File 3KB
8 30 Objects [] MemoryzetuditScriptaxml 1 XML Document 21k8
B Desktop |5] Readmena 4 Text Document 1KB
(5] RunRedlineAudit.bat 4 Windows Batch File 1KB
Documents
IS 1
7| Readme.tct - Notepad — [m] =
File Edit Format View Help
g g - c = = v
On the Windows machine you want to audit, run the 'RunRedlineAudit.bat

script, preferably from removable media (e.g. a USB Hard Drive). The script
ill run the Collector, as you configured it, and save the results to a
folder named 'Sessions\AnalysisSessionl'. Every time you run the script,
new AnalysisSession folder (AnalysisSession2, AnalysisSession3, etc.) is

a

When the collection is finished, transfer the results back to your analysis
machine, then double-click 'AnalysisSession.mans' file located inside the
AnalysisSession folder.

A9 @« TUsunsy Mandiant RedLine 8
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= Application Tools  Cap_Ram
Home Share View Manage

+ » ThisPC » Local Disk(C) » Users » User » Downloads » Cap_Ram

”  Name Date modified Type

# Quick access

Size

Sessions f20214:34PM  File folder
[B Desktop )
%04 /30/20214:25PM  File folder
‘f Dovnloads ¥86 2021 425PM  Filefolder
|5 Documents elevate.cmd Windows Comma... 2KB
= Pictures elevatevbs VBScript Script File 4KB
& OneDrive - Personzl finishAnalysis.js JavaScript File 2KB
getNextSessionFolder js JavaScript File 1KB
[ This pC getPathyjs Javabeript File KB
) 3D Objects Helper.bat Windows Batch File KB
I Desktop \J MemeryzeAuditScriptaxml XML Document 21KB
) Documents =| Readme.txt Text Document 1KB
RunRedlineAudit.bat Windows Batch File 1KE
; Downloads
| NV

V) Search Cap_R..]

A e TUsunsy Mandiant RedLine 9

[

189970 cmd Ualukansiazlalua fadl

Organize = Open  Shaewth = New folder
¢ Favorites i
B Desktop ¥ nomensi-a-22
J§ Downiceds || nromancff-v1-92.mans.cache
E Recent Places win?-32-neomanoff- memory-raw 01
winl-32-neemanott-memory-taw
A Ubraries
¥ Documents
o) Music
Bl Pictures

i Viceos

M Computer

S Network

aromanoff-memory-raw.001

A7 @o TUsWATH Mandiant RedLine 10

Woellaldeuaiunsanlual Analyze data > From a Saved Memory File %30

anunsalannlianiiuivana .mans lolaense



- Yool -

Open an Analysis Session
Attempting to upgrade your Analysis Session. This may take a few minutes...

Cancel

| im_ReadLine

Share View
v > This PC » KINGSTON_DF_RTAF (E) > Image Ram > im_ReadLine ~| & | searchimR
~  Name Date modified Type Size
# Quick access
AnalysisSession.mans 1/30/2021 1230 PM  Mandiant Analy ,211 KB
[ Desktop *
] AnalysisSession.mans.bak 1/30/2021 4; BAK File 11 KB
3 Downloads »

A7 <er TUSUASH Mandiant RedLine 11
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T vmdk
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StarWind V2V
Converter
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19911N15 Run TUSBASUTULLAL IAYINNNSLEeN P2V wagnm Next

O starwind V2V Comeerter

Select location of image to conwvert
- P2
Cormeert physical machine or disk

) Local file
File on the local madhine

) Remote YWMware ESHl Server
Wirtual Disk or Wirtual Macdhine on remote ESH Server (version 5.5 and later versions)

) Microsoft Hpper-V Server
Wirtual Dish or Wirbual Macdhine on remobe Hyper -V hypervisor

) Azure
Microsoft szurs

) AWS
Amazon Web Services

Mext > Cancel

mW‘ﬁl ®o WshNsU Starwind V2V Converter 1
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\d@en Physical Disk azna Next

.e

) starwind V2V Corwverter

Select physical data to convert

) Digk Volume
Cormert single disk volume to virtual disk file

(®) Physical Disk

Cormvert phiysical disk bo virtual disk file. Volume structure is preserved. It is possible to
select a set of disk volumes for copying to virbual disk file

) Entire machine
Migrate this physical madhime to new virtual maschine

Mext = Cancel

A ®e TUSLASH StarWind V2V Converter 2

\don Disk Mifiudoyavesszuudisieanisasyin VM-Ware

O starWind V2V Corverter

Select physical disk to convert

Select disk
SanDisk SDS5DA 240G o
Wiokume Label Size Fres Space Required
B ooy 223 GB 59.0 GE 154 GB
] Wwiwolume{a. .. 201 MB 403 M8 208 MB

AT o TUSWATH StarWind V2V Converter 3
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1N Local File waznm Next

&« O starwind V2V Comverter

Select location of destination image
(®) Local file
File on the local madhine

() Remote VMware ESXi S erver
virtual Desk or Wirtual Machine on remobe ESX Server (version 5.5 and later werssons)

() Microzoft Hpper-W Server
Virtual Disk or Wirbual Machire on remobe Hyper-V hypervisor

 Azure
Microsoft Azure

) AWS

Amazon Web Services

==

A7 e TUSWASH StarWind V2V Converter 4

@on VMDK wagnm Next

“— ) StarWind V2V Comverter

Select destination image format
) WMDE
WMbare Virtsal Machine Disk

P WHDAYH D
Microsoft Virtual Hard Disk

O QDO 2
QEMU qoowe 2 disk image

MG SR AW
Rawe disk image (img). This image format is suitable for Starvwind. Disk space for this image
is allocated at the coeaton ime and does not changs ower time

[

A9 e TUSWATH Starwind V2V Converter 5
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1d0n VMware Workstation growable image Wazna Next

&« ) starWind V2V Corverter

Select option for VMDK image format

(® WMware Work station growable image
Disk space for this image is allocated on demand, so disk size of this image grows over
e, WARNIMG! This format is not compatible with ESXi wwmndk format!

) WMware Work station pre-allocated image
Digk space for this image is allocated at the creation time and does not change over time.
WARNIMG! This format is not compatible with ESXi vdk format?

) Sream-oplimized image
Monolithic sparse format compressed for streaming. Suites for using with OVF packages

() ES*i Server image
Sedect type ESX image

Addbonal options
[[] activate wWindaws Repar Mode

Mext > Cancel

AT e TUSUNSY Starwind V2V Converter 6

nsaslnawmesamsuiulng VM-ware

o
{ & O starWind V2V Converter
{

| O Savets X
ination fil m _
Set destination file name Saven [ Crbertianing 03 £ v @@®em-
Mame ’ Date modified Type =
File name * . .
- ) 630419_cif 4/19/2020G:31PM  Filefol
[ ¢ pesxroe-scsssss. md - Quick access Automatic Mouse and Keyboard 27152020 11:50 AM  File fol
File info - CyberWar 12/9/201911:25AM  File fol
Space needed to save converted image: 180 C8 FA-18 Operation Desert Storm 2/15/202011:59 AM  File fol
space avallable on drive C: 69.0 GB Desktop ipwa 2/17/202011:13 AM  File fol
program 3/16/20205:20PM  File fol
m spack 1/17/2020:15PM  File fol
Libraries vm 3/25/20208:13 AM  File fol
aplilnacduning2 3/6/2020 &:0T AM File fol
[‘ andilnmouuilnG3 3/16/20205:28PM  File fol
This PC i 2/28/20207:53 AM  File fol
) vm_notbook| 4/23/2020 11:18 AM  Fille fol
v
¢ ,
Netwerk
Fii name | DESKTOP 8G5E855 mdk v|
Save astype: VMware image files (* vmdk) v Cancel
B o r “
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Wensyurunsiasadulazna Finish

T X% T X
© 9% - StarWind V2V Converter © Finished - StarWind V2V Converter
Converting Converting
9% 100%
| 28 .|
Burning Log: Buming Log:
Time Information Tme Information
11:18:51 Started 11:18:51 Started
11:18:51 Taking snapshofs... 11:18:51 Taking snapshots...
11:18:56 Taking snapshot of volume C:\, - success 11:18:56 Taking snapshot of volume C:\ - success
11:18:56 Success 11:18:56 Success _ .
e Crestrgoutputimage fe 11.2 :er ;:dmwcmm m;ue q»-‘ thook\PESKTOP-8GSBESS. vmdk
1:18: cCess: J= E:! X 55.w
11:18:57 Success: Created fle E:\wm_notbook\DESKTOR-8GSB365.vmdk wews: Created fie E:m_notbookip v
11:18:57 Converting 11:18:57 Convertng...
o ’ 11:43:17 Success
11:43:18 Converted successfully!
Finish Cancel
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Inld vmdk diagy ldansnsaidadulusunsy VMware Workstation ot fieevinn1sdig
Inldnou

thook

pre View

This PC » Cyber-training-03 (E5) » wvm_notbook ~
MName - Date modified Type Size
|=] 15.png 4f 11:44 AM - PNG File 310 KB
% DESKTOP-2G5B865.vmdk 4724, 0:25 AM  VMware virtual dis... 147,224 64..,
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Nnulsivinsidnlng vmdk Tagludiumy File > New Virual Machine Wizrd..
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Type here to search

=]
File Edit View WM Tabs Help » - ) Lo = R
T | New Virtual Machine Wizard x
O Type here to search
| Choose the Virtual Machine Hardware Compatibility
= [ My Computer Which hardware features are needed for this virtual machine?
[[] WebDeveloper
[C] pfsenst virtual machine hardware compatibility
[C] Web for pentester Hardware compatibility: | Workstation 15.x e
[F) Windows 7
Compatibie with: X S
[T] Windows Server ompatiae ES¥ Server
[C] Ubuntu 16.04 Desl Compatible products: Limitations
[ SIFT-Workstation Fusion 11.x 64 GE memory
Shared VMs Workstation 15.x 16 processors
10 network adapters
B TB disk size
3 GB shared graphics memory
Help = Back Cancel
~ Virtual Machine Details
State: Powered off
Configuration file: C:\Virtual Machines\SIFT-Workstation\SIFT-Workstation vrmx
Hardware compatibility: Workstation 14.x virtual machine
Primary IP address: Network information is not available
\
N U StarWind V2V C ter 11
- - T T —1
Edit View WM Tabs Help [ ~ ] o [ B2 O

Mew Virtual Machine Wizard

Guest Operating System Installation

1l

My Computer
[C] WebDeveloper
[[C] pfsenst

[C] Web for pentester

[[] Windows 7

[C] Windows Server 20
[[] Ubuntu 16.04 Desk

[C] SIFT-Workstation
Shared VMs

A virtual machine iz like a physical computer; it needs an operating
system. How will you install the guest operating system?

Install from:
() Installer disc:

CD Drive (G:)

-

() Installer discimage file {iso):

F:\Programs\Windows 10\Windows 1809.is0
(®) I will install the operating system later.
The virtual machine wil be created with a blank hard disk.

Browse...

Cancel

AT eoe TUSWATH StarWind V2V Converter 12
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. - )
Tabs Help | B - ] Iy == {u} Tabs Help P - ==
| New Virtual Machine Wizard x Mew Virtual Machine Wizard X
h
— Select a Guest Operating System Name the Virtual Machine
Which operating system will be installed on this virtual machine? Wihat name would you like to use for this virtual machine?

T er

e S virtual machine name:
Pt | @ Microsoft Windows tester ‘ Windaws 10 |

O Linux
er 20 () Apple Mac 05 X ver 2l o
Deskl () vMware ESX |4 Des .
ion | Oother ation | |+ vm_notbook [ Browse...

The default location can be changed at Edit > Preferences.
Version
Windows 10 ~ ° e oo & o . Iy
fvualiaimeimzdaiu vm asitiuifeniulug vindk
Help < Back Cancel < Back Mext > Cancel
P
AN @0l TUSWATU StarWind V2V Converter 13
|| Mew Virtual Machine Wizard X

Name the Virtual Machine
What name would you like to use for this virtual machine?

Virtual machine name:

Windows 10 |

PO VMware Workstation Y
ca

The specdified location appears to contain an existing
wirtual machine. Having two virtual machines installed in
the same location can cause problems, induding loss of
data if the two virtual machines have the same name.
Would you like to continue with this location?

o

< Back Mext = C

ncel

Firmware Type
What kind of boot device should this virtual machine have?

Firmware type
@ Blos
(O UEFT

D Secure Boot

Cancel

< Back.

AT o LUSWATH StarWind V2V Converter 14
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| Mew Virtual Machine Wizard | Mew Virtual Machine Wizard
| Processor Configuration ! Memory for the Virtual Machine
Spedfy the number of processors for this virtual machine. How much memory would you like to use for this virtual machine?
Processors Spedfy the amount of memory allocated to this virtual machine. The memory size
Number of processors: 1 - must be a multiple of 4 MB.
Number of cores per processor: 2 = 4GB Memory for this virtual machine: MB
g Eric:
K Total processor cores: 2 15 GE
8GB «
4GE W Maximum recommended memory:
1GE 9.7GB
1Ge 4l «
517 MB M Recommended memory:
256 MB 1GB
128 ME
&4 ME Guest 05 recommended minimum:
3ZMB 1GB
16 ME
8ME
4 ME
Help < Back Cancel Help < Back Cancel
T T

A @oc LUsHhN5N StarWind V2V Converter 15

| Mew Virtual Machine Wizard

Metwork Type
What type of network do you want to add?

| Mew Virtual Machine Wizard

Select IO Controller Types
Which SCSI controller type would you like to use?

Network connection

() Use bridged networking
Give the guest operating system direct access to an external Ethernet
network. The guest must have its own IF address on the external netwark.
(®) Use network address translation (NAT)
Give the guest operating system access to the host computer's dial-up or
external Ethernet network connection using the host's IP address.
() Use host-only networking
Connect the guest operating system to a private virtual network on the host
computer,

(O Do not use & network connection

1O controller types
SCSI Controller:
Euslogic  (Not supported by Windows 10)
LSI Logic  (Not supported by Windows 10)
®@)L5I Logic 545 (Recommended)

Help < Back

cane

Help < Back

Cancel
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| Mew Virtual Machine Wizard

Select a Disk Type
What kind of disk do you want to create?

File

ibrary

Virtual disk type
ODe

(scst (Recommended)
(@) 5ATA

CINvMe

ol

w . = w
idan SATA Tdmsafiuusziny Disk veansasfugiu

Help < Back

Cancel

SIFT-W

Edit

= I My Computer
[T) WebDeveloper

arkstation -

pe here to search

Mware Workstation

b'

View VWM Tabs Help

Mew Virtual Machine Wizard

Select a Disk
Which disk do you wan to use?

IC) phaenst ok

[T] Web for pentester
[ Windows 7

[T Windows Server 21
[T Ubuntu 16.04 Desl
[[] SIFT-Workstation
Shared VMs

(O create a new virtual disk

A virtual disk is composed of one or more fles on the host fle system, which
wil appear s a single hard disk to the guest operating system. Virtual disks
can ezsily be copied or moved on the same host o between hosts.

(®) Use an existing virtual dick
Choose this option to reuse a previously configured disk.
" (OUse a physical disk (for advanced users)

/ Choase this option to give the virtual machine direct access to 2 local hard
disk. Requires adminisrator privieges.

o & d C) )
\HonduiiioaslATHIWE vmdk Aldnwasfuatu

A @oo LUsHNTN StarWind V2V Converter 17

| Mew Virtual Machine Wizard

Select an Existing Disk
Which previously configured disk would you like to use?

Existing disk file

F:\wm_notbook\DESKTOP-8G5B855. vmdk

|| Browse... |

=)
szyieglla vindk

Help < Back Mext =

Cancel

Help < Back Cancel
m
J MNew Virtual Machine Wizard
| Select an Existing Disk
Which previously configured disk would you like to use?
Existing disk file
Fiy vmdk || Browse...

0 VMware Workstation X
L4

@ Convert existing virtual disk to newer format?

= The chosen virtual disk can be converted to the
newest format supported by this Workstation 15.x
wvirtual machine. However, after conversion the virtual
disk will be unusable with older virtual machines.

Keep Existing Format Convert Cancel
Help < Back Mext = Cancel

"
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MNew Virtual Machine Wizard X

Ready to Create Virtual Machine

Click Finish to create the virtual machine. Then you can install Windows
10.

The virtual machine will be created with the following settings:

Mame: Windows 10 ~
Location: F:\wm_notbook
Version: Workstation 15.x

Operating System: Windows 10

Hard Disk: Existing disk F:wm_notbook\DESKTOP-8GSBa65. vmdk
Memory: 1024 MB

Metwork Adapter: MAT

Other Devices: 2 CPU cores, CD/OVD, USBE Controller, Printer, Sound... %

Customize Hardware...

< Back Cancel

A7 o= TUSWATY StarWind V2V Converter 19
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&a N3EITRD9Y Sandbox

Sandbox {unsAumITawIsku Static 1519899 Snapshot VM-Ware sagiase Tngly
Adavuvafu o drude Window 7 1uinIesiiazinifanad wag Remnux aztiuinios
vadinaduaradrs DNS Uasy 1591 Sandbox flnnusunsiesossuudsadarn VM Ty
Host Only wasfinnsiourefuszUUAIBUeN 1WoiduasoeBuINILHLSIENToaNLUY
Network Aausnaziiinsaslunsnaaeuiiedes Ineiluagld o 13es fe wdewinnlisa fu
3o usLiu Logs wazsrassdumesiinuasy Undifiagld VM Ramnux Tag Set
Tiaeufinnoiiaannniosedluis LAN ifieafu vaaaudienis Ping mifu uLazn15un
Sandbox G’Tawaé’aummiﬁawaaﬂ’]im%m’ﬁmmaaw‘%amié’mL@‘%&Jmammmﬁaumi

7AARINDU B LANTZUIUNISADNPADILALADLLDINY AININ

MATATEIY setip wul linux  sudo ifconfig ethD 192.168.180.128 netmask 255.255.255.0
ST sanbox sudo route add default gw 192.168.180.1 ethd
VI remunx Wadumadia  inetsim
sila dns Yaan fakedns
W windows vTlw ip valdezas Linux

E LT
hitps:/fwww youtube comfwatch 2v=4L:Cragfs O

w1 save Wi cov

i csv WliladuTalsunsy Don.... v

AN @@o N15Y11 Sandbox

dlemTouaninuindeuvesnisaasulaiaiouiosuds Junsudolufonisyin
Sandbox ¥sensFiiunsvaaey TnefiswaziBundsl
&0l 3371 Sandbox BuaNWa VM-ware Remnux Liiovns Set A IP
Ty Network Weatutuados Win7 wisldaiuisansraduuiniinuazadradu DNS
Uaoul#iu Sandbox 1aeila Command Line w&afiu¥ends # sudo ifconfig etho
192.168.75.101 netmask 255.255.255.0 wag # sudo route add default gw 192.168.75.1
eth0 mmfuﬁﬁﬁﬂ’]ié’]dﬁﬁ’l Network VM suaqﬁgqaaﬂﬁl,ﬂu Host-only ﬁwm'ﬁam&?’qiﬂiumu
Process Monitor wag Process Hacker Uy Win7 fnuunaa IP Address Inelsf Gateway 1du IP
983 Remnux Waweiariulasass drefds #>sudo inetsim 1Wa Terminal Fuslvaiuda
Fn15aM139 DNS S180989 Remnux #nefds #>sudo fakedns
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[T} KakLinux-2019. 1-vm-amd64 [ Windows 7_64 [[¥ remnux-6.0-ova-public

Forking services...
=] * smtp_25_tcp - started (PID 1854)
n * ftp_21_tcp - started (PID 1858)
. * smtps_465_tcp - started (PID 1855)
REMnux * pop3_110_tcp - started (PID 1856)
Tools Sheet * ftps_990_tcp - started (PID 1859)
done.

) Simulation running.
* _h 0 44 n_-
=

NS File Edit Tabs Help
CheatShe'remnux@remnux:-s sudo fakedns

sudo: fakedns: command not found

remnux@remnux:~$ fakedns

Using default IP address in responses. To over-write, use a command line option
pyminifakeDNS:: dom.query. 60 IN A 192.168.1.1

3 £d PLD 8
remnux@remnux: ~

AN eee &S #> sudo fakedns

Mg Snapshot 30umie Win7 udafiurinuieiay 1P Address o4
1A384 Remnux TusTI@eszLanmTdIesnsdausunsldeuvedUsunss Remunx wans
Frszvundenldenil VM ves Remnux Waldswnsa Wireshark dievinistufinainngiae
Ta .pcap Network suaamq]mitﬁl,'ﬂ AlUsWNTU Process Hacker way Process Monitor
vinnsidesTnsiea sensedndisusnsay udinaBuneiines adnfisuuiu uazmaile
Rernnux Wivin1silanisueilnes Network ynistnandawisuazsutawds 7 VM-win?
Tidaunglnsiwavesiaur$ilusunsy Process Hacker Inganu13asinis Kill Tnsiva
voaifauflfdaeTusinsu Process Hacker AilUsins Process Monitor nagUiiuvenenass
dlevgnn13n 193U antu Save lUIWES .csv 7 VM Rernux alusunsu Wireshark wé
Save W& .pcap uazla fakedns Uaou ilennasuadaudlivinistuiin logs 91nluswnsy
Process Hacker lngaglalndidy txt

This file 1s an HTML document
"8 Process Hacker [PC\ptt]
Hecker View  ¥¢ jsers  Helg
<= > Options @B Find handles or DLLs 4% System information | w2 earch Processe tel K o
s808 | Services | Network | Diskc
PID CPU UOtotal.. Privateb.. User name Description
| o 9380 0 NT AUTHORITVASYSTEN
263 0.02 218 MB Chent Server Runtime Process
=7 wininit.exe 404 1.42 me Windows Start-Up Application
ks = a2 i 8232 08 Cliens Se. o, 4
kol m save As . ]
6.
‘§ C o » Computer » Local Disk (C:) » Program Files » Process Hacker2 » -~ |42 | F o
; Organize ~ New folder - © |
’2 & Downlcad:
- Recent Place
< plugins
b2 86
2 CHANGELOG .t
7 COPYRIGHT .txt
74 LICENSE.txt
;2, README.txt
2,
2,
= % Computer
- &L Local Disk (C:)
74
74
- File name: [Ges -~
2 =T x
7 Save as type: | Text files (".txt:".log) =|
-
-‘ = Hide Folders L Save By Cancel

AN eelb haMINTS SULUSHASU Process Hacker
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#ulusunsy Process Monitor azansnsaidentaineg save Wuliduszianla
EnBulis PML azanunsadaduTusunsuiuld wisvsdeniduuuu CSV wde XML 91niu
39%ng stop nsveuvesiusunsy Wireshark Tuils Ramnux w¥eutufinlnd .pcap uae
Ynan5vi191uwes Terminal fakedns /U inetsim 1usuadadun1svin Sandbox &msuns
Aalna s ﬁs&auagﬂiiuiv@é POF vhldidnasds #>pdfextract § Jolud.pdf uwda s Folnd.
dump /scripts/#>pdfwalder 3olvd.pdf uananil Tu VMRamnux 2zilusunsuiianuise
Anilndienans Office Iilunlashiailsoguiolishomds #>OfficeMalScanner Falyid.
doc info, #>0OfficeMalScanner %alv\lﬁ .doc scan %58 #>RTFScan %aiﬂl\lﬁ.doc scan,
H#>RTFScan @olwd rtf wde #>Malzilla 9510y GUI Tneadniiufiu Decoder udananiuiiing
Aon Load from file udndonludfidenis f\]’]ﬂﬂf‘IJﬂmquiJ Run script azudnssianazlan
ponun Wivhnsadndnads avunngdenudsenafudsdvesiauad uenanidaiinisih
Sandbox wuupaulaudndly §935n15Aen 15U lNE R desasdelunsradeuiiSulys

Joesandbox (https://www.joesandbox.com/#windows) AILEA4

J)ESandbox =8

Deep Malware Analysis

L - * .
& W e
macOd Aaracircid Linux Adhwanced

g Define Sample Source and Choose Analysis System

1 Upleas Sample G Browss URL Moow Options
[ ——— T3 Dewnlond & Exseuts File
max 100mb [ — B Command Line

Cj Choose Anashysis Syvtem

Selwct up 50§ of 1 avaiabie pystems.

Sk B P
Adcte Pleader O

0 Live Interaction

S Live Interaction & Results

B L Iraracsion

e Settings

) Comments 0} Execution ! Run Tieme
B 0 0 nec
-1
W@ Four complene analyss vell be published on this webaite and acces sible o amyone (ncksding soeenshon). Upgrade 10 Cioud Pro io pet 8 prests Boocesnt
a Accept Terms and Conditions
agren 10 De bound by T TenTs and Condons Bnd The Personal Dats Protecton Fokcy 8o sgree 19
T e e Analyze wilh Joe Sandbac

29 een ULYEA Joesanbolbox.com
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Uanemns Port fild3udsdoyaiiinsfudilndignienldasiiiuiiogueddid hitp status
o19ganludadnumsnistudideyainfuuuy get/post/request Famansafienaifunsly
#1&3 Command line %38 Sql Command Taufidnun wiesnaiinisensiadenisidsia
. Base64, Shal, Sha256 $aufian1sda Byte Code Wnunluszuy tevinliiAnnsufias
nsbiusnsAUled 139sUNIUNISTNNUYBITEUU dmMTUNTIATIZIA Network Forensics
Iruvsgonulusunsufinig ne ldenu Useneudaelusunsy Wireshark, Imperva, Security
Onion uaz Deep Instinct Inefisneazidoanisldeuuaznisimszdsielsunsurianun
i TUswnsy Wireshark 14lun153ias1e9i Network Forensic delusunsufiiaiaaiionilefivag
51 Wunguuesdoyafiintuiniiusinumitlng Tnsagreduainnisliau 10 Graph Hu
myieavesteyauinifniiivanldiuuansmaluguuuuvesnsm Tasflaansavihmsiden
yaveatoyauaninaldnmiidiosnislnededddausauiu Filter Statement aazuAnmng
9110 TCP Flow Graph Dudu

b.o NSuEAAINAlABN1SIEIU 1O Graph
0.0 @UTOVINNNTFURUBALULLILAYL x uazw y La (TCP Flow Graph vilakid)
vel @unsamvuadvasnnlunisuansdayala
vo.a aunsaimuagukuuveanswld wu ns1du impulse WWudu
po.c asnsaldgnsmandamansiitomuiunaiiliuazuansuadingmle
bod awsaUsuLny y Iiuansmauuy Logarithm ieuankanfiaunndietuannle
bek ANTANIAIEN 9 AFesnsumihnswannaiieUTeufisunuduiusuld
g9gn & yadeya
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il Wwshark - 10 Grapha - cultput posp
Wireshark 10 Graphs: output.pcap
Vo000
| |
|'-'.
" 300 \ .\I | ”
?: .1”-'.1 *| ). lII| d \ I W llr ! f
B o T B
| " ﬂ‘,"l | i
I L S A 4y / 1)
) | ;'\ | | A -."'Irx. ""'||, hatal, 'II \ III \ A "| ! vy
=y 1
m “ ' :
AL o 11L || Y U R S ——
0RI=1 0 3640 9 40: 50 (b #2200

|. Irl l. |.l H T 1708, 18 .08, 1% Lo, 18 7.0 18

b e b rant S Ge

LEF e i Graph MHarme Diapdey Fies oo [T

= Dt 182,188, 1 ipadidrn m 172 084,119 Bl hposddr TR MO8 1.9 Al beppeoet 207+ I [
A Doait VR, VR i adden s VT2 164,119 Bl wp.adids i J Bl v it 2ors [
S Ce PRI  ipaddes s TTE VA, TS B0l i adiive Q\.IM1H\|,\|“.W: «xra B L
T ¥
L = By 1 i (W) i ags e el 0 e ] Tores oof oy b L i Hrael
ad Ad Ciop [ Clos ] (2]

A eed NISUARINAMY 1O Graph

v.0.00 NISUAAINAAIY 1O Graph N1511 10 Graph unl¥uaniwateyavzlndeyaind
ANazlBgAluNITUARIHAN LAY Wag N1sNYadeyANLAnINaLiBlUSUIB Uiy
AatulilonaaulanaInsendelusunsuvinaueyly seuu Network Weafiu n3eidl
Source-Destination iAgatesiufavainisadigadeyanlaainnis Filter Junvinnas
LARIN AN DS UIEUNNTINUNTEAURAUNATIB19 98 Rin YU e liseuu Network
losunansenutiuldegadaaunsil n1sldanulusunsy Wireshark lagunfiuaiiilosfenis
MdayauNeE1tunITNATes Client 799015100 Connection WalsuAeNa13AULATES

& = a v oo < & = S a

Server A1ULLONINIMNGBHLILTUAUIINITN WNLAR TCP SYN n3alunsdlniinisla
Connection azAaadnisdsuiiniia FIN 1iiei3un15Un Connection N1580813 3aNsdilin
ANUAANAINBULIUNISARWANA Re-transmission Tunsdlifl n1sesvedeyaivianmely

= al ¢ @ @ ' = - ' o v v - <
nsddnldwinifndvwnlvguin nsnsenuininfinaeazyilaein Weswinuiniin
SYN/FIN qgiinsdeeanuiiesuanianes Aeiulusunsy Wireshark 3silia3asile dmsunis
o ca o o A a X (3 < A a 4 v & a
WasvmgnisalfdAgyinduainwiniamdaduniluliswnsulilvduae Expert
Information tuas taglu Expert Information agvinn1sasuanuiaunfivesnisdoansuay
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M Wireshark . Expert Information - output.pcap am a x
Severity Summary Group Protocol Count Gl
Warning TCP window specified by the receiver is now completely full Sequence TCcP 17
Warning Connection reset (RST) Sequence TCP 5
Warning TCP Zero Window segment Sequence TCP 89
Warning This frame is a (suspected) out-of-order segment Sequence Tcp 1306
Warning Previous segment(s) not captured (common at capture sta... Sequence TCP 2812
Note This frame is a (suspected) retransmission Sequence TCP 3260
Note Duplicate ACK (=1) Sequence TCP 9224
Note This frame is a (suspected) fast retransmission Sequence TCP 2391
Warning ACKed segment that wasn't captured (common at capture... Sequence TCcP 1
Chat C ction blish (SYN): server port 2074 Sequence TCP 4
Chat Connection finish (FIN) Sequence Tce 8
Chat TOD windaw tindata Canianca Tro AR v
< >
No display filker sec.
Group by summary Search:
Close Help

A eeo WaAMBLAaTUNLAAN Expert Information

ALY Column ilsuansdeyafiniinlnsuniudalusunsy Wireshark
wfimsuanaanmiivelusunsudurinatses WsunsuogudAenn Default iloltuanswa
wuuhludadtsswesionislénueguia usluuiensdl fldnudosnshdeyaursetnaiimies
aulalunanwmatiielanusansaaoun1sineures Network fitdsiinsest dadunisuia
yodayaadiuiiioviluuanwmaidu Colurmn miSadumadeniimvidlinislinseiasmnnniy
lnglusunsu Wireshark advayuauannsailvgldnuaunsnigndoyauuaniwald
MUTFBINNG 19U NSUARINATESAN TCP Time muJumauathiLmiu Wireshark @1113091
msfuauldanuiinfanaund amnsardoyayaiuuaniaidy Column iudsld
WULRBIRUMIUANT @0 N151AT TCP time uuansnatlu Column iinuulusunsy
Wireshark n13ld91u Profile siafiosaniadoniaifia Column ilatsdosnisdoyaduun
uananaLiie iz iumsldauiinneiniednudeyaanuiiniAnlnonsiiivyadeyasiis 4
1@ Column vas TCP delay %158 HTTP Response ivelianinsasualgsenniu uilunsed
flsifoansgruandinaraunds nsuansua Column wdniufaznanefudoyaildldgnlda
wagnanedudafisuniunisvhau esnnidunissuniuaen fafulusunsy Wireshark
aldfinsdanslusindlunmsuanssadoyatunniioldudly wu lunsdiidesnsinmed
M3viuYes HTTP Aliviinisdnniswansaliuiauuagyinnisduiinidu HTTP Profile
seuiledaenisinsgideyanisldeuiediu Database Avin1saianisuaninaves
Database uaztiufinly nsdifidesnsldauuuuunifivihnng Senen Default Profile 1nlday
ddeinsnauluBiasiziinisvinnues HTTPAYINIS3en HTTP Profile nauunldaulaviug
MIaduUNIsanINaTes Profile wuull faudavegunisnisléan snndnsldnuuuund
Feagspafimatansuanswalminnadsiidesnslinisuanmadoyalunuueniziangag
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M webpeapng - 0 X
File Edit View Go Copture Analyze Statistics Telephony Wireless Tools Help

A0 InRBRecgTiTEaql

(W [hooty o deghay fiter . <Ctlf> ) v| Bpresson.. +

No. Time Source Destinaton Protocol  Length (TCP Delay
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blo.m.e Service system> Parent Process : Default Part = ligunsaasnala

310 image, Number of Instances : Parent Process = 1, User Account : User Login =

Local System, Start Time : na1sudu = At boot time (Gﬁuagﬁm’aaﬂumiyjm, Description :
System 9z¥n15UsEIANARATSUARYoU L INL AN uegadivinauniglé
Systern.exe ax48u Child Process 1A .sys uadsdl dll Savanasafiviiaiuniy Kernel vos
szuUU§URnIstiy 1wy ntoskmlexe Wudy

blo.mlo Service smss.exe> Parent Process: Default Part Uﬂﬁ%éfaﬁagjﬂ[,u

System\root\System32\smss.exe, Parent Process : ¢AUANS = System Number of
Instances : Parent Process 9%l Instructions Process , User Account : User Login =
Local System, Start Time : L’Jml,é:uéf‘u Lﬁmsﬁuﬂﬂwé’amsgasﬁmaqssuuhjﬁ'%mﬁ,
Description : fintd7ilunisadne Session wazinstructions ¥4 Instructions aza¥19 Child
Instructions I@aﬂizmums%ﬁ'uﬁuﬁszwéaEJGUEN windows (csrss.exe & womomot.exe)
el Service wininit.exe & Session = 0 Lag Service winlogon.exe # Session = 1 ‘vﬁagquw

o.lo.n.e Service wininit.exe> Parent Process : Default Part = UnAazA o
agﬂu SystemRoot\System3 2\wininit.exe, Parent Process : & §14ln8 Instance Y®Y smss.exe
ﬁ\iﬁ?uméaﬂﬁaﬁﬂ%lﬂﬁizq%aﬂ'ﬁzm‘um‘mﬁﬂ, Number of Instances : Parent Process = 1,
User Account : User Login = Local System, Start Time: naNSUR Lﬁmsﬁumwﬁﬂmiyaﬁ
10333 UUlIAIUT, Description : avSudiulaeazidu Key vos Backeround aneld Session 0
Wazay Start Service 8n m fiaAe Control Manager (services .exe) ,Local Session Manager
(lsm.exe) WAy Local Session Manager (lsm.exe)

o.lo.en.c Service taskhost.exe> Parent Process : Default Part UnfAag@es
agjﬁlu SystemRoot\System32\taskhost.exe, Parent Process : S¢AUANT = services.exe,
Number of Instance : Parent Process = 1 Mgammﬂ’l, User Account : User &andu =
Local System, Start Time : nasuduldudusuLasiauLandsTueg 19N, Description :
Junseurunsuszananalnswa 4 luves Windows Tasks Manager Tagazdl Universal
Background Process Manager (UBPM) ‘1/1°NW@§L5@W§'& L1 User login, Start System ,
a1wes CPU, Windows log event, 1A389 Lock 13 01A309 Unlock 1 udu 391uu1nnin eo
semsfitnuam3amilunsiasaduasuduves Windows 7 Enterprise (wii3mane
N 1 U
AzgnUalden) 1y defragexe gnmmuarialiinisviulunniuns ¥390a1 oeco
uaeiimsdsastoyalsld nau Registry vdnn 9 eo Tu Husiu Ui iRmvamun (OLLS & EXE)
Aldnuduasuiu warldlunsfimuaiia Windows 7 uwag Windows 8 agléfusadlas

Microsoft
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o.lo.em.& Service lsass.exe> Parent Process : Default Part Uﬂﬁ%éfaﬂagiu
SystemRoot\System32\lsass.exe, Parent Process : 5¢AUANS = winint.exe Number of
Instances : Parent Process = 1, User Account : User Login = Local System Start Time :
a3y etunendansyaduesszuulaiiiundl Description : = lsass.exe Windaifiue
Local Security Authentication Subsystem Server process %’Uﬂ@%auiumimwaaum{f
TnsmsiBenglidnmsmudasadoveauiinin fmunzay (SSP) Mssusesaugniesiissy
Tu Rigistry HKLM\SYSTEM\CurrentControlSet\Control\Lsa Tnesialuazifu Kerberos SSP
g miuda@lanm vde MsV1 0 SSP 1@ w3y local accounts Weglildsunisusesay
Qndias lsass.exe avadrslmAunisididsdmivglifssyand uazdodiiaduanulaonsde
AUy wagnsruruntsesnedunesdliiviniu Fafunssurumnilesnszuaunisiiens
Antu waglimsiilusiaagn

o.lo.an.o Service winlogon.exe>, Parent Process : Default Part Unfiagfed
agﬂu SystemRoot\System32\winlogon.exe, Parent Process : iz‘Uq?i‘vfﬁg a3519lABNTEUIUNITVDS
smss.exe ﬁ’aﬁ?um%‘laﬁﬁaiLﬂswﬁﬁmﬂﬁﬁszu%amzmumwé’ﬂ, Number of Instances :
Parent Process = 1 #38u1nn37, User Account : User Login = Local System, Start
Time : 1381336y msiulﬁ%mﬁﬁumL’Jam“aéﬁ’m%’umzmummiﬂ @msuratu @) 1an
Suudmiunszuaumsiuduintuiiefinisadasadulmilaeiluniunig Remote
Desktop visen1siingsruunisadugldednesanids Description : Wuszuumauldgldiaa,
login %38 logoff gnialdaulay Service LogonULexe %qaz%’u%a;ﬁ%uamﬁa HIUNLENR0
\igszuuuazdiiuteyaiuseslud lsass.exe anraseuteyasusouiloflilisuns
$UT89AIUYNABILAT Winlogon.exe Aglvan NTUSER.DAT vog asly Registry HKCU
LL@%SM‘IAL%&?W@Q‘LG{? (explorer.exe) WU Userinit.exe

o.o.an.e) Service iexplore.exe> Parent Process : Default Part Unfiaz @ e 90 gJJIu
System\Program Files\Internet Exploren\iexplore.exe % 3 ® \Program Files (x86) \Internet
Exploreniexplore.exe, Parent Process : 5¢AU@NT = explorer.exe, Number of Instances :
Parent Process = 0 #38111n71, User Account : User Login %uaéﬁudﬂﬂilﬂuﬂ login
410, Start Time : 1nansudu lnavialy Lﬁ'a;ﬂ%’ﬁm Internet Explorer agnglsAniu
nszvIuMsfsnaannsaENduldlnglidesudslimsuaami nsldnouvesyldtiuaing
“ -embedding” (lunsdlil Parent Process o1alaily explorer.exe) Description : = Internet
Explorer (IE) {uneuUnaiagu Desktop ﬁalﬂﬁﬁwim;ﬂ%’uaﬂw%m%’u wazidudiudesras
explorer.exe IE nosfulmingiinszuiunisdesdnivusazuiiviilneg fomananats
Usens swdsanudaonsefifisdudoddivleitumesidn IE audonldnszuaunsudiv
Feaudndedefidndziduauendmuglauiiezvinisutlaiiufisoulnives
Registry #3035z uuUlndnInniIniuIa1uisanlIuAy Child Process v IE Q‘Ia}uaﬁﬂ%@?q
Fosfauas iexplore.exe wagaalilulaisnnesdrses (misspell Explore.exe) Tidu iexplorer.exe
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blo.m.c Service explorerexe> Parent Process: Default Part = Unfiagsl aﬂagﬂu
SystemRoot\explorer.exe, Parent Process : S¢AUaNS gnas1alagnszuIUNITVBY
userinit.exe é’fa{?uLﬂ%aﬁa"iLﬂswﬁﬁﬂazlﬁlﬁszq%amzmumwé’ﬂ, Number of
Instances : 3’18?1’1361'6@%}171' Logon wuul@nau, User Account : User Login %uaeﬂiﬁ’udﬂm
Hugf Login 1 Start Time : ia1Fudu = Bulonisidigszuuuuuldney Description :
Service explorer.exe vWuilandnues Explorer Faelvifldaruisadnelng Tneviniig
Furslnldiusiweini Windows Explorer (uiiffams explorer.exe) wagBumasinavaely
WU nanney LLﬁ%LlI‘IéL%MLLOUQ’]U“U@QLLNQWJU?}@J Hudu weundnduiideldnunnisdenles
fuduvenelild way Shortcut AIsTiBaNTlanszuIUNITYRS explorer.exe YUy
nsingsruukuuldneulagliAdsimidisig Windows Explorer ﬁLﬂ@Imwﬂeﬁﬁéﬁmm
explorer.exe ﬁgﬂéfaﬂﬁua@u SystemRoot andlalsnnesuinnin SystemRoot\System32
fnasdudlond nsaeisdotawasuasmaniurin explorer.exe wagdlilu System32 udo
misspell explorer.exe vensandy expl.exe

b.lo.e.« Service lsm.exe> Parent Process : Default Part Uﬂﬁ%fﬁaﬂagﬂu
SystemRoot\System32\lsm.exe, Parent Process : 5¢AU&NT = winint.exe, Number of
Instances : Parent Process = 1 , User Account : User Login = Local System Start
Time : LamL‘%'ué’fuLﬁ@sﬁumwé’qmwﬂmaaizwhﬁ%mﬁ Description : {JuA153AN5UIANS
Terminal 57UDNLwETU Remote Desktop 59104 local sessions L‘ﬁlmﬁmimmiaé’wﬂ%mu
NM530a15U smss.exe LwaLiaJLézjastjuiwaJ 1A8 smss.exe @319 csrss.exe LAy winlogon.exe
memmwaauuauummﬂm witiu Fafunsruiunisniwesnszurunsiinsasiniu
wazlimasil Child Process

blo.meo  Service svchost.exe> Parent Process : Default Part Uﬂafwagﬂu
SystemRoot\System32\smss.exe, Parent Process : 5¥AUaWS = System Number of Instances :
Parent Process = 5 tkag Child Process User Account : User Login %LLG}ﬂGi’NﬁJuVLU%{uagj
funszuIunng svchostexe wiilaeluazdutad Local System, Network Service %38
Local Service nsyurumsiivhanunielisyddulamslasunisnsinaesy Start Time : 1@
T lunneluldAdunfivewansuduiau sgrelsfniuauiseisy Service liudn
919dNalAAANTZUIUNTTINLUBY svchost.exe #dIa1N1IAT Description : NTzUIUNITLaA
kU mSu Windows Services fugnlddmSunisisenlduinig DLLs Windows azi3enly
svchost.exe Ma8NszUIUNIT weasdldnsdiwes “-k” ﬁiﬁ%’lﬁ’uﬁm%’umﬁmnzjuu’%mi
ﬁﬂﬁﬁsﬁu NS0T “k” ‘171|J3VL°LJ 59484 BTsvcs, DcomlLaunch, RPCSS, Local Service
Network Restricted, Netsvcs, Local Service Network Service, Local Service No Network,

Secsvcs Wag Local Service And Nolmpersonation ;3/ \WousTauas
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a¢ldUsyleniann svchostexe Tlnensaielnedaniiiodoutau’ Inonseazingatauss
Wuuinislunszuiunisfigniiosues svchostexe waglaedouaznaunarufunsdiignies
194 svchost.exe Ingaznadoianainidniion (scvhost.exe) inaznagniosudandlily
Directory Buiilyly System32 svchost.exe ‘ﬁaﬂé’fmmiﬁaﬂwf\]’mﬁf%mﬂﬂ SystemRoot
\System32 hae mim services.exe LWunLsUS 5’;mmmsmmmﬂmumwﬂaq Windows 7
WaLazUSMsAsLiun1see . DLL edusaslag Microsoft

blo.mee services.exe> Parent Process : Default Part Uﬂa%éfa&a@ﬂu
SystemRoot \System32\services.exe, Parent Process : SLAUANS = wininit.exe, Number
of Instances : Parent Process = 1, User Account : User Account : User Login = Local
System, Start Time : nmwmmummumwmmiuamawwﬂmmum Description :
Umﬂed Background Process Manager (UBPM) FaSuRnvouianssuiumas Wy USnsuay
ufimnun Services.exe 1 Service Control Manager (SCM) Jan1susnasiuan wag
aﬂﬂiaﬁmnaimmLﬂiawmwmm‘uﬂ?'ﬁLimaqumimaLa‘WW‘” uaﬂmﬂumasﬂmmai“uu
wuuldnauladnisa SCM (services.exe) Wf\]’ﬁmm’m’]iuﬂﬁlﬁ%if\]ua? 1GE mm‘mmmu Last
Known Good (HKLM\SYSTEM \ Select\LastknownGood) Tidumives CurrentControlSet

blo.melb Service csrss.exe> Parent Process : Default Part Uﬂafwéfmagj
Tu SystemRoot\System32\csrss.exe, Parent Process : S¢AUENT @3519lagnsguIuN1u99
smss.exe é’aﬁ?um'%laﬂﬁaiLﬂiwﬁﬁﬂﬂﬂﬂﬁwﬁBﬂizmumwﬁﬂ, Number of Instances :
Parent Process = 2 #3811nn71, User Account : User Login = Local System, Start
Time : Laa%‘éuﬁumsluhﬁ‘imﬁﬁumnmuﬂa&ﬁﬁm%’u b N38UIUNITWIN (FmTuwatu o
LAY @) NasuFudnTunsYUIUNISIERiuTumilaulml LLazL%%’Wzgﬂﬁ%’ﬁ%&ﬂ%ﬂ%ﬂ
WHNzaNRMBYETY o way o Wiy

blo.@ Registry kagn15m1UseIanisldau usb aanUu Run w3aldAddn Window +

RWUN regedit WdInA Enter WadINALENLY LU Y AN i HKEY LOCAL MACHINE
\SYSTEM\CurrentControlSet\Enum\USBSTOR n1511938lusunsa USB Forensic Tracker
v1.1.3 msuanldnou uaznaty Run tisliszuuyhau

% Rumn >

Type the name of a program, folder, document or Internet
resource, and Windows will open it for you.

U

Open: I regeditl VI

[ OK ] Cancel Browse...

Al eloc Regedit
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Lo FUILNTUALIANNUIALULR (Task Scheduler)

(<}

Fde  Action View MHelp

4= = | = o)
(D Task Scheduler (Local)
~ L Tak
~ 0 Microsoh
2 Office
1 Wendows
1 XbsGameSave
1 Monils
1 541-5.21.2252267713-
O Symantec Endpoim Py

<

Name Status  Triggers

5 GoogleUpdateToskMachineC... Ready Multipie triggers defined

@ GoogleUpdateTaskMachneUA Ready At 7126 PM every day - After triggered, repest every 1 hour for a duration of 1dd | 1

B npcapwetchdog Ready At system stantup RO
B OneDrive Standatone Update—. Ready At 7100 PM on 5/1/1992 - Aftes triggered, repeat every 1.0000.00 indefinaely.

@ OneDrive Standsione Update. Ready At 500 PM on 5/1/1992 - Aftes triggered, repest every 1000000 indefintely. fangave Tadlea

Ossplay All Bunning Tasks

®

General  Triggess

Actions  Conditions

(Lecat ©

Settings  Mistory (disabled)

When you create a task, you must specify the action that will cccur when your task starts.

Generst  Triggers Actions Condtions 4
Wihen you create  task, you must specify
open the task property pages using the Pry
Action Detaits

Start & program C\Program fites {

Stant a program CO\Program Files Fua
< >
New_. Kda Datete

===

Cancel
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b N15ATIZI Malware Analysis

witeendu m dau Ao nsfigaulid, n1sulnd wasnisiiessiidednssauilaidu
voslld dwiunsfigedlidarunsavitlévnatsds daurfiosfiifiunainuatounas lufid
¥p8nA10819 Tauriiin1sgeudaeglu Ram FelianunsansranIeduniainiaios
aeufiwesld Wesnldfinisadidlngle g Bluszuu Fsdunnazerfuansusuedusunsy
Powershell Tuns3usies dmdunszuiumsiesgiiazizuainthlid Ram fivunldnyh
N3UAN Zip 08nfou AN obo

£¥ Windows PowerShell

> Get-CMDevice

SmsProviderObjectPath : SMS_CM_RES_COLL_SMS0O0001.ResourceID=167
AADDeviceID : 00000000-0000-0000-0000-000000000000
AADTenantID : 00000000-0000-0000-0000-000000000000

ActivationLockBypassState

ActivationLockBypassStateTimeStamp

ActivationLockState z

ADLastLogonTime : 11/22/2021 7:08:54 pPM
ADS1i teName SSCD

AMTFullversion =

AMTStatus

ATPLas tConnected

AT PUnboal dingState

AT ~ T A

AN eme HUTWATH Powershell

vinssuluanalnd 20211207.mem 191 Kali Lwalﬁﬁﬂmﬂﬁm Volatility ‘Lumﬁalmwm
ezjwasfl,ui UUUUANIT Kali Linux 1da Terminal AINTURU A imageinfo
WewReundouszuy newhmsilnneideya nialdds #>volatility-f 20211207.mem
~ profile=Win7SP1x86 \iifuwinfinissulndezlsdosasdeniiu Inswala 9 Tussuundeld
Wans9znUdn Insiwa powershellexe aneway PID 2848 dn1saninilnanliduisegnefiv
asdoarnivledaneuen Wenmasdnluisnazainnse andinanliduisedraunld Tned
dnwaizfuliidsunmiide d.png fnmil ole

v s Extract
Home Share View Compressed Folder Tools

— - 1 > This PC Local Disk (D cif > df2022 2 ok

# Quick access
= 2zip 3/1/ 47 PM onas WIinRAR &
=™ This PC

B 20 Okinces
- =B 27ip - WinRAR

W&E dds  wioalio Twumshhe dufon 5519

2 . >
" DABLI WD @ s
= w |- g
- Wondh wunlUil| waaou Sumn shehu  tYouasin g | hiaaunu #oduw SFX
= m A 2.zip - wnms ZIP, vueats 2,128,605,184 Tuw
& o vun anifu  vila anurily CRC32
“lm
- 20211207.mem 2,128,60 666,964,.. MEM File 12/7/2021 . 20548.

N

A7l omlo TWswnsy Volatility
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Mndurhmsnnaeulndtaurdidesiuseuled Virustotal.com Bnsegnaiisio
mMslszidauifiendila Tnefldauudanilidsng q Mduliiniasveundesgn
Wasuuuana uazasdunaléinlndsing q fvihaegnivdsuumanadu hacker sisvun
w¥oufuilludFonaldide ReadMe.txt dusndasuduuinana du 9 Snuszana @ und
fufegnduandumilouudn uanvindesdilusunsuuisedeiinesilasunmanaveslind
wianogedigiaaan dlu Windows axdlusunsunisiiviminiidanainisulusunsuld
wazsingnlddanaland duRelusunu Task Scheduler Fsagdasluntiaaay uaznuiriiie
yosdamilaiiiaund fie GoogleUpdateja 91nnsnsIvAoUTIBaztBen sznuilusunsugn
& 3 1 W
Sulvdtawnsfide ukbat vn q & Ui Fanmil elole

AN eeen NN5ATFBULNAT ARSI UDIAU

.o N193AT18RRIUTUTLATY Deep Instinct Faidulusunsuuounlisanie
Uyyiuszhvg danuamnsalunisiesisi uazlimanuiiaziluveisgneiuingiany
14 no.laanfdunisiadslusinsudinaniuunissnouiamesiiotesiutauisann

a 5

Suwmeiidn uavdgnldiluwugesdmiunsiaduiarenunaundsdiunarsieldinsey

[y

foanmuuuazerldau Werwnlylusu Forensic TUsunsu Deep Instinct agaunsalv

[

Tayavadldninisindauds uarngAnssudns1aiamiensiuasulladiiewmasniian
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IP Address wuUdmluRvMliATaIRauRmesinIsiUasuLUas vunewaulP Address

AT e Lans Dashboard 983lUsinsu Deep Instinct

salb 1155ulid Wunsmeasuiulnddawisuuaaimwindeudiaosiodinszi
NOANTTUVINAWIT OAUMILLINILALY Tn8azABIvnUUTEUUT188991L38n31 Sandbox
N153AT1ETENsEAuTladuraslng Wunisiaudilaflsddunisvinanuvesiawas
aAunngAnssuienateusy nion1sgnunsnasinauveslysunsuluaniizuni Wy
MU TUNTUATBIRAAVY NS ENTUNYINNUDMU LSRR TaMsiTAnsalusunsy Crack
nfifawas usu Tnedruunazldlusunsy IDA Pro lun1sinsneat deldazdestiniuslu
4{' a = & - Jo ! 3
[309UININWDALUUE (Assembly Language) Baulunwiaies wenaniidaiinsgeulus
o W I3 fa -~ % ] v v = a ¢ v
Sawisindulnagunn Indddle vselndienansing 4 lasnde 3an15aineiagaesanunse
Aalvlddananeeninneu wu Mssulndteyaddn azldmamanini obe Dusiu

root@kali-training: ~/Desktop/fa
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v MIszyYIULUUINE 51919Anivhludesssyluidleusgudrindulridunana
o¢ls udegduilndinTesneufinefansagniudsuulamieudluls uay usninesfisnay
Gonldi3denan wWievsdeulndnIevisniaszuuiiiolvaiusardiuilssdunisnsraaeu
uwanalwdidonniivanlndidunlussuy fadunisvi Forensics iitevningunuulndiiy
Tuduegls aimusndy wavlunsutetu CTF drusnndedldmdamnarilunismeineu
Fafisamdaan wu A1ds mdls Tu MacOS 3o libmagic luszuu UNIX wazdnduly Linux
\fagldrdadn File Wudu

b MIwanWdFdn Wunszuiumsiiewsndiuusznevvediidesnun adnefu
113 Unzip wiazuansnadunsafianunsanensialwdfilinsivanneuldse @ulng) was
mmﬁamsﬁa;ﬂaﬁgﬂezj'auagﬂu"LWaﬂlﬁﬁﬂﬁasJ lnedled b mdenfenld Ao binwalk -e udanu
sedolng Lﬁ@ﬁﬂ%}aiﬂaLﬁ’aQG’TULﬁEJ’Jﬁ'UVLWéEUﬂ’IW waz mds foremost 1urdsiilddmsu
unnlvidfgeusgeenin

Edt View Search Terminal Help

AN @eo ANEY foremost & binwork

« @ usr share | wordlists » Q| =

[ - — 2 - 5 )
e " .

b Lt d| Extract | + rockyou.txt.gz Qs @0 0O
top

Hﬂ { > ||| Location: | &/

fments rockyou.txt s¢
ploxs 1399MB  plaintextdo.. 03 fluwrau 2013, 20..

ras

- o o a Y s .
AN eael AdUABIRULING Zip
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Unzip Wald n3eranalid nsdl .oz 119 gzip -d audaedelnd
Details v agldoyalsdniierfuaiifegluiladsie q vesguuuuioya zipinfo uans
5'1aﬂﬁssﬁagaﬁ'mﬁ’uLﬁamwaﬂlﬂ/\lé zip Ingliisosunnluld zip -F input.zip —-out output.zip
wag zip -FF input.zip —out output.zip o8 ugauLLNING Zip fideme fcrackzip brute-
force dunssiariu zip (@wiustariuiliiiu o Snuse) feududosindalusunsutszing
Dictionary @13Un15%1 Brute-Force Tulusunsunaaauanuuasniasyuu 1 Kali Linux
aufiulnddmsuld Brute-Force 137 /usr/share/wordlists/ TWddain rockyou.txt.gz Jasas
Mmsuaniidesnindeu sensdudandndilig wideon Extract Fanmil ome

:~‘Desktop# unzip flags.zip
Archive: flags.zip
[flags.zip] flags.txt password:

password incorrect--reenter:
password incorrect--reenter:
skipping: flags.txt incorrect password
:~/Desktop#

AN @ rockyou.txt.gz

IntuiinsAnaeninauslifulnafagyininas Brute-Force uaalddnds
#> facrackzip -u -D -p /Neguaallé/rockyou.txt Falwdfeanis Brute-Force.zip w3pagly
M zip2john AlG 1w #> zip2john abc.zip > hash.txt, #> john hash.txt {uu

00000150.zip fasttrac > hunting 1 psl.txt rockyou. txt
fa hash.txt hunting 2 ran VMwareTools-10.3.10-13959562
op# zip2john 00000150.zip > hash.txt
total 136912

drwxr-xr-x 8 root PR 10:45

drwxr-xr-x 22 root root 2021

-rwWXrwxrwx 1 root root 2 :57 00000150.zip
drwxr-xr-x root root 4 :38 ]
“rW-r=-r--
“rW-r==r--

3
1 root root 2 142
1 root root :48
drwxrwxr- 2 root root E 122
drwxrwxr-> 4 root root $ : :50
-rW-rw-r-- 1 root root :04
drwxr-xr-> 2 root root :45
-rwxrwxrwx 1 root root 139921507 :26
drwxr-xr-x 3 root root 4096
drwxr-xr-x 2 root root 4096

- Desktop# L
Created directory: /root/.john
Using default input encoding: UTF-8
Loaded 1 password hash (ZIP, WinZip [PBKDF2-SHAl1l 128/128 SSE2 4x2])
Press 'q' or Ctrl-C to abort, almost any other key for status
badboys (00000150.2zip)
1g 0:00:00:03 DONE 2/3 (2022-06-04 10:49) 0.28329g/s 3939p/s 3939c/s 3939C/s gangstas..fernandas
Use the "--show" option to display all of the cracked passwords reliably
Session completed

: Desktop#

AN eene® Brute-Force
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compare evidence
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computer network systems
computer security system
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conviction

court

crime

crime analysis

crime patterns

crime scene analysis

crime scene investigation
crime scene photography
crime scene protection
crime scene reconstruction
crime scene search
criminal law

criminal justice administration
criminal procedures
criminal procedure law
criminalistics
cryptographic system

compliance

cloud

- @O0 -

[

N15UIENBUDNYYINTIY
nsnTIUSE Ui Uae it tednluds
WIbueuneunang

N5R0LNMABLNIADS

JEUUATUVIEADUNIADS
sruuALUaRnuAON NS

n1sagUNe
nsmuANrIgalunsEuIuNSERTITY

nsadlny

Aa

91U INTTY

NTIATILVRIVEYINTTY

sULUUDWRINTIY

mﬁmmw‘iuamuﬁﬁmm

MsAsIRAILTLARLR

msengnmluan iAo

s NwIAnUTIARYA
nsUsznawmansalluaniuiiiomg
nsfumluanuiAamg

NVNIEDIY

NSUIMTIULRATTTUNDIRYN

N3EUIUNITNNDIY

NVIUNEITNANTUIAILDIY)

nsigaivangu

JEUUNINTTA
n1sUfudnIungseioude AU wasnguune
napnauNTURURnNUleUIEAUaTAUALAZ Y
Uaonfgv8d8dAnsog1egnaed lanuunsgiy
Wy MU URmuUsenAnsgIUns I neAiUaense
TumsUszneugsnssudidnnselind lneanznssunis
gansadidnmsetinduazmsdnvhusu esesiu wu.
waznsg). Auaulasndevdannsedng Judiu
@Snnesvesiliuinsuudumediin denszarvey
pufising « talen asliiuiisudlddledutoyasia 4
Tiuwdle udfanldnulaluynaunsaluagyniian



cybercrime

data mining

database system

data warehouse
deciphering indent
detecting
determination
diagnosis

digital image processing
digital photography system
dimensions

document processing

data Forensic

electric circuits
electromagnetic waves
electron microscope
emphasized

erasure

estimation

ethical

ethics

evaluation

events

events surrounding
evidence

evidence identification
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evidence, documentary
evidence Collection Form
evidence preservation
evidence, Criminal
evidence, Expert

evidence in rebuttal
examination of handwriting
expert witness

expert witness in court
exploratory

exploratory data analysis

financial fraud
fingerprint

fingerprint

forecasting of crime patterns
forensic accounting
forensic finance
forensic science
forensic science history
forensic scientists
forgery

forgery detection
foundations

fraud

fraud examination techniques

fundamental biometric systems

fundamentals of fingerprint
forensic Duplicator
faraday Bag

forensic Artifact
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gather

handwriting

hot spots
hypotheses
hypotheses testing

identification
identification of individual
image attribute

image capture devices
image enhancements
indented impressions
indexing

individual project
information systems
information technology

information technology security
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method

models

motion

memory Dump Tool

mobile Phone Forensics Tool

malware (malicious software)

network Security Officer

nontechnical attack social
engineering

network systems

network security

Net

obliterations
observation
obstacles

open Security

open Systems Security

operational Data Security
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operations Security (OPSEC)

performance
perpetrator of a crime
person identification
photograph

physical evidence
preparation
preservation of evidence
printing

print out

privacy

procedures research
processes

processing algorithms
protection
professional

proof

print out

public safety

phishing

research design
research hypothesis
research methodology
response

retrieval
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retrieving
rules of evidence

rules of evidence relating to fraud

sample
searching
security
seminar

secure socket layer: SSL

seminar in Forensic science
signatures

source determination
specific methods

storage

storing

spam mail
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Social Network

techniques used to detect
testimony examination
techniques

technical attack

testing

training in court

undercover

unique

recognition concepts

virtual Private Network
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